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Instructional Methods for Innovative Teaching and Learning:

1.ICT enabled Teaching and Learning : In addition to chalk and talk method of teaching, the
faculty members are using the IT enabled learning tools such as PPT, Video clippings , Audio
system, online sources, to expose the students for advanced knowledge, practical learning that
which makes teaching learning process simple-and more effective. The major emphasis is on
classroom interaction in terms of research paper presentations, seminars, debates, group
‘. discussions, assignments, quiz/tests/viva and laboratory work. For better understanding and
learning of concepts, new technology provides various tools like Prezi, TED-Ed, Xmind.

Outcomes Observed: Realization of the course content is straight forward. Class room

dynamics got improved.
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2. Virtual Teaching: Students are made familiar and encouraged with the online learning
environment platforms those which played a crucial role and made teaching possible during
covid pandemic through google classroom, Microsoft Teams, Zoom ...etc that which also helped
the students to adapt to grasp the teaching from the MOOC platforms.

Outcomes Observed: Students understand how using digital technology tools could help in

boosting task efficiency.
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Presentation of Honorarium to the Market Makers Event Judge, Mr. B. Durga Prasad, Branch A
Manager- Utkarsh Small Finance Bank, Vijayawada.
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Andhra Pradesh 521108, India

. Latitude Longitude

16.5188068 N 80.7000493 E

Local 11:57:34 AM Altitude -56.5 meters
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Geo Tagged Photo of the Stock Game First Round at Explorers’ Meet 2K23.
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Participants in the Group Discussion Round @ Young Manager Event

Presenting views in the Just-A-Minute Round @ Young Manager Event
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Andhra Pradesh 521108, India

Latitude Longitude

16.517766 N 80.6999816 E

Local 01:59:53 PM Altitude -60.6 meters
GMT 08:29:53 AM Friday, 25-11-2022
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16.51764962° 80.70010316°

Local 04:59:14 PM Altitude -44.92 meters
GMT 11:29:14 AM Monday, 09 Jan 2023
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Latitude Longitude
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~ Local 10:07:40 AM Altitude -60.6 meters
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Fig: Students Participating in Group Task
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XMIND

XMind is a mind mapping and brainstorming software, developed by XMind
Ltd. In addition to the management elements, the software can be used to capture
ideas, clarify thinking, manage complex information, and promote team
collaboration.

Introduction

The objective of this tutorial is to introduce real estate students and other
readers to Mind Mapping, a technique that is useful in generating new
ideas, developing processes, and project planning. Since the best way to
learn the ins and outs of any tool is to apply it to specific cases, this tutorial
applies XMind to real estate decision making. While this tutorial focuses on
XMind, it should be noted that much of the functionality can be replicated in
many of the other mind mapping packages that are available. XMind is built
‘on an open source platform, allowing for customization and enhancements
by developers and advanced users interested in customizing their mind

mapping.

Mind Mapping

Mind mapping is the “art” of creating a visualization of some process or
decision. It consists of a series of topics or steps that are linked together.
Once a process has been mapped, it can be converted to template or
model that can be modified and/or extended to other processes or

" decisions. However, rather than being a rigid, checklist type of modelling
process, creating a mind map is a dynamic and interactive, allowing the
designer and/or team to think freely and inclusively, not worrying about how
things are connected as much as making sure the key components are
identified. Once these building blocks or “steps” are noted at a general
level, attention can turn to how they are connected as well as what they
entail. Since mind mapping is learning, it takes on a continuous nature in
which new knowledge can be integrated. So, sit back and start opening up
your mind to a new way of thinking; a form of People Learning that can help
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o)

us compete with —and direct-- Machine Learning. :

5 3 1 1 &% ' Project Overview
@ 9 i communication/Documentation O i |

— 2 {3 S-E-L Analysis [

o 8 ERintegrated MFU Analysis &~ -~ 2
: ; REAL ESTATE PROCESS:
SITE IN SEARCH OF USE

H 1
| |

| Lo 4 gl Akernative Use Scenarios 2 @

@ 6 {1 Most Fitting Use Analysis L3 i il

H-—— 3 ] Legal/Stakeholder T

@ 7 EiFinancial Analysis & ———4

L 5 giMarket Analysis

To provide students with examples of many of the features contained in
this tutorial, several XMind maps created by the author and embedded
herein are available. Other interested parties should contact the author at:
JRDelisle.

Installing XMind:

1. Download the free version of XMind deb file which includes 32 and 64 bit versions (download
links below).

2. Once you have the deb file. Double click it to start the installation.
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i : Package Installer - xmind
File Help

package: xmind

Install Package

status:  All dependencies are satisfied
Description Details Included Files
" XMind - Brainstorming and Mind Mapping
| XMind, is an open source brainstorming and mind mapping software tool
developed by XMind Ltd. it helps people to capture ideas, organize to various
charts, and share them for collaboration. supporting mind maps, fishbone
- diagrams, tree diagrams, org-charts, logic charts, and even spreadsheets.

~ | Often used for knowledge management, meeting minutes, task management,
. and GTD. XMind is compatible with Freemind/Mindmanager.

|| XMind is dual licensed under 2 open Source licenses: the Eclipse Public
| License v1.0 (EPL) and the GNU Lesser General public License v3 {LGPL).

o
Once you click Install Package, you'll be prompted for the admin password in order to begin the
installation.
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Package Instalier - xmind

Installing xmind

P Terminai

Automatically close after the changes have been successfully applied

il § installing ‘xmfnd-ﬁnux-l0.3.200904291819_f386.deb'...
%
]
!
|
i

3 Once installed click close.

Before purchasing XMind (2020) subscription features.
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What is mind map presentation

A mind map is a tree chart that organize information visually. Mind map presentation is to use
the mind map as presentation slideshows. Your presentation software = mind map software.

Here is what a real life mind map presentation can look like - . (This is just one of the way
topresent . In XMind, we provide various cool features for you to present.)

Track Daily

/—- Priority First

Retrospective -'/

- Batch Process
USE THIS FREE MIND MAP TEMPLATE

How can | customize your mind map templates?

1. Pick a mind map template from this blog post or XMind Share. They are ALL free to
use.
2. Download the template you like. Then download XMind to use them. No account
registration required. All the necessary features are free to use.
Open the XMind file. Double-click on any text box to edit the text (or select a box and tab
SPACE to edit).
Use ENTER to add same-level boxes, TAB to add sub-level boxes.
Present directly in the software.
(Optional) Export to PNG or email mind maps for free.
More cool features below... Here's a sneak peek of what XMind editor looks like:

L

~N oo
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Using XMind

Create New Workbook

There are two alternatives for creating a new Workbook from scratch:
selecting a Blank Structure; or, Selecting a Template.

Exhibit 5: Blank File Creation Options

R Heene - Fraject 1 310 Capturinn ol Exinple_vlarmmd
drw

i

Create a New File: Option 1: Blank e RO TP

e*’”ﬁw

Balancierd Hng U e o Bumicad s 1Ltk
Pick one of the Formats;
can be changed later,

Depending on your project, you might find a prepared template that you
can use as is or that you can modify for your needs. This will fast-track the
process and give you some ideas that you might adopt in your work.

Exhibit 6: File from Template
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XMind uses the term Workbooks to refer to separate Files. Once you launch
XMind and choose Blank or Template, it will open a new workbook that
shows up as a tab name “Untitled.”

Exhibit 7: Workbooks

|| el et Modity Tools Window Help

" Mew. CtieN |
New Blank Map Ctrl+ Shift+N
= Open.. Ctrl+0 1? Citrss v
Open Recent T R T
XMind Workbook Sheets

Basic Structure/Features

Depending on whether you selected a Blank form or a Template, you will
see the same basic structure with several features. These include: 1)
Ribbon options which toggle on for more detailed choices, 2) Common
tasks as shortcuts, 3) a list of Open XMind Workbooks (you can cut and
paste among files), 4) a Central Topic or your starting point, just click and
relabel (if you selected a template there will be more topics), 5) a tab
indicating Sheets in your Workbook at the bottom (you can add more; right-
click to rename), 6) expansion/navigation options that open upon selection,
and 7), advanced features available in the Pro version (e.g., Export to PDF,
Brainstorming, Gantt Chart, Convert to presentation).

Getting Started

Given the intuitive nature of XMind, for many or you the best way to learn
and draw from this tutorial may be to create a new blank XMind map and
experiment with it as you explore the various features. To get started, once
you have a Central Topic just mouse over it and you can replace the text

PRINCIPAL
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by simply typing into the box. If you want to wrap text to keep the box
small, use SHIFT-Return to start a new line. At this point, Click on the
Central Topic box and enter the TAB key; this creates a subtopic. If you
want multiple tabs coming from the Central Topic, just click on the box and
enter TAB again. To create a hierarchy, Click on the Subtopic and TAB.
You can repeat this process to lay out your basic structure.

Although you should give some thought to the layout and structure of
your map, it is often more important to get your thoughts/topics on the
screen. Once there, you can easily CLICK on a topic and drag it to a new
location: that will alter the map and move the TOPIC and any
SUBTOPICS to the same branch or location. The UNDO Icon in the
favorites bar let’s you roll back changes

PRINCIPAL
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Exhibit 8: XMind Layout

0 ProFeastures ~ = %

Ele fod Yen [hiet Modfy Jook Undow Heip

Ribben Options

Fal — proTn

o > Common Taskg Lo S RS RO
: 6 e ; jac g iais A
Open XMind Files Expansion Options 6 i

for Navigation and |
Tools o«
<}
=
) -
o/ ' E 5 | Topi 1 B
; entral Topic =

_ e | ;
-]

Starting Point;

Click and Rename ¥

lf

Worksheel(s). Can i
¢ add more i
fherhlics AL PR AN D e, e pi > At Gk
Togihe (Central Topix Auln Gave DFF - ROSUSIE
. -~ Add Topics and Subtopics
R
Overview

There are three ways to populate your XMind; using the tab key to add to
each topic/subtopic, adding in the Outline Feature, or using the Insert Tab
and drop-down menu. There are four kinds of topics: Central Topic (the
starting point), Main Topic (first level), Subtopic (multiple layers of topics),
and Floating Topics (placed anywhere without linkages).
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Exhibit 9: Create Topics by Tabs

and enter Tab

F(;mtral Topic i

To create Tree Structure; click on Topics

¢
| 8
By clicking back E ]

ta Topic 1, you |

spie can create new {
257 Subtopic ‘ E3
Q .

oton:
o !

. Sl n

143

Create Topics Via Insert Tab

You can also Create Topics by using the Insert Tab and selecting from
the dropdown menu. In addition to pointing to the Insert Tab, you can use
the shortcut ALT-I (note, this syntax is used for each of the Menu items).
As noted, the topics can be placed anywhere depending on which Topic
you highlighted and which option you select.

Exhibit 10: Insert Topics

fnsert Modify Tools Window Help

Topic Enter
] Subtopic Tab
! Topic Before Shift«Enter
Parent Topic Ctri+Enter

Floating Topic
Floating "Central’ Topic
Callout Alt+Enter

Once you have created topics, you can
rename them by clicking on the Topic and
typing in the desired label. If you want to wrap
text to 2 lines, use CTRL-ENTER. @
(X

PRINCIPAL
SRK INSTITUTE OF TECHNOLOGY
ENIKEPADU, VIJAYAWADA-521 108,




Floating Topics

Floating Topics can be added via the Insert Menu or by quickly double-
clicking oh the open Map. This is useful for brainstorming and getting
Topics on the Map which can later be placed where they belong and
populated with more detail. Floating topics can be renamed, and can have
Subtopics enhancements.

Exhibit 11: Floating Topics to Brainstorm

3 Floating Topic

Create and
Move to Subtopic 2

I
i
e : | Add
[ : : Subtopics
| Real Estate Process: {

Site in Search of Use

__Change Order or Layout of Topics on a Map

To move topics, simply drag and drop once a connection is automatically established. Sub
Topics can also be inserted to change the order and/or add more features to the map.
Connections can be deleted which creates a form of Floating Topic

\\\~
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Exhibit 12: Changing Map Layout/Topics

Expanding/Collapsing Topics

For each Topic/Subtopic you create, XMind will add a placeholder until
you rename it. To the right of each Topic with Subtopics, a small + Icon
appears. You can toggle that on and off by clicking on it. In Expand
mode the Subtopics will be shown; in the Contract mode (-) the
Subtopics will be hidden.
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Exhibit 13: Expand/Contract Icons

Expand/Contract
lcons

W

Expanded \\

2.7 Positional Analysis

1 Overview

2.1.2 Objective

| 2250tc  ® o
! { M

_ 2 81 2. S-E-L Analysis E .,-:_ 2.3 Environs &

s £ & 24 Linkages & ™
. ‘I‘. 25 -‘mDi?‘CEUOnSOfS‘E-L ContractEd

Mind Map Structure

In some cases, changes to the order of topics may change the basic
format/structure of your map. To apply a different Structure or Layout,
. RIGHT-CLICK on the topic of interest

e VB2 SEL Analysis £

et 2 KR 3 !-‘j'_.ll-f"»‘.amrhu,‘dc-r. i3
- 3 BB 4. Design Thinking §3

Jl. ‘1_ e 4 BB 5, Market Analysis (23
} Real Estate Process: e
i Site in Search of Use - -
l_ ! Wi ; - %5 B 6. Financial Analysis £

e 687, Most Fting Use [~ Jo

i 7 e Dr_.-.n_—mw.:|.um.P:og.ra:1mnu1; [ pR‘thpAL
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Changing Structure

To Change the Structure of a Map, go to the MAIN Topic and RIGHT-
CLICK. At this point you will see “Structure” as a menu option.

Exhibit 14: Select Structure for Changes to Selection

|2 BN N e e e T R e — e
. . i
2% Site in Search of Use 3, . .. m BalancedMap (Upto down]
2 Insert * = Balanced Map (Clocknise)
. - Markers '
m . Balanced Map {Anticleckwise}
e ™ Qg Chart (Up ta down]
5 Mew Sheet From Topic Ctrl+ Alt=T
R : w  OrgChart (Down to up)
g . wa - - A
Capy CuteC Trae Chart (Right}

Paste Chri+y Tree Chart (Left)

Duplicare - Logiz Chart (Right)
Delete Delete

= Logic Chart (Left)
Copy Style
Py Sty ] Timeline Herizontal
Paste Style
Reset Style "™ Timeline Vedical
Extend All . # s Fishbone (Left Headed) e }
Leflapse All ! = » Fishbone (Right Headed) ' '
9 Sort » T Matri (Row)
: ClStegetre 0L T » B Matric (Celumn)

@)
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Exhibit 15: Fishbone Structure & Optional Themes

Other Themes for Fishbone ~—

e
s, —
o,
3 L“":-..
o
Y
L4 o 7 o AR i e 3 /
Real Estate Process: SRy o :
—_ - Sitein Search of Use T e i =
. AR 4 ! T
@ o

Outline View and Thumbprint

To View Outline Panel, click on icon to upper right. You can change labels
and/or add topics from either the map or the Outline Panel. The TAB
addition will work in either and the results will show up in the other frame.
Another useful feature for larger mind maps is the Thumbnail preview
screen activated by clicking on the EYE-icon. If you scroll around in the

% preview, the larger Mind Map moves around s as well.
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Exhibir16:Create ToplesinOutline, =~~~ . 3 :

VN N, Pt e a

' Real Estate Process:
Site in Search of Use’
i e L G aayes ()

—~ : e AL pgatrs et [

1 epes Chemims i bobd sty | Gagal udshabi £ D in

Changing Formats

There are a number of ways of accessing the Format options, including
RIGHT-CLICK on a topic or selected group of topics. Again, you do not
have to completely enfold the topics of interest, but just overlap part of
each one to include it in the changes.

| Sameann
e -- { Yo
. i 18 7 1. Project Querview [ } B e 9
i . -

- [ 2ER2.5-E-L Analysis & }

Exhesthnd Semdig

Baberchuif Serralight S ot
Eber b Ok Face

Brusburrs ¥3

e AT

Bartn Sana PR

Herhin Sans FR Derrs.

Real Estate Process:
| Site in Search of Use

-———[ 3 B3, Legal/Stakehoider &

e ®m B F B %
i

Eernard WMT Condunind

iy { 4 fi4. Design Thinking O } o Tt = ] Packadeler (T
Soden 24T

A Beddani WT Biack

w

[ 5 88 5. Market Analysis 3 }

SRK INST!
ENIKEPAD

U,VIJAY&WP\DA-SN 108.




...... N ) Suctopic t
I Overview | sumese?
z Sutteot
Intro to XMind At PR
{ |
{102 ] sumo
E Main Tope 3 i
43: Mt Bk | i s P SRCT RS S
Teps: |
Thes
o . Copy. Duplicate
i_l_':: ! or add New
: Sheets
ey L M Bieek Shaet Q=T
0 Tiow Shest From Cosednel
Z_. W Colodul Tak s f

Exhibit 32: Adding Sheets

Exhibit 33: inserting Sheets via Menu
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various types
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this case, a
problem-
solving model.
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Make Sheet from Topic

Once you have a basic structure, you can make separate worksheets for
each element. This can be helpful if your model has a lot of detail and/or
components which could be unwieldy if constrained to one sheet. To add
a new sheet, right-click on the topic you want made into a sheet, and
select Insert '

New Sheet from Topic. The Insert also allows you to create a new sheet
with the same name as the topic and Link to it from the Main menu.
Alternatively, select topic and right click to see Insert Sheet. This will pull
the Topic and its Subtopics. Note that editing at the Sheet Level will not
show up at the Main Level so you should think about how detailed you go
for each Sheet.

There is a work-around that you can use to update the Main Source sheet
if you want to include more details from the individual sheets. Before
making these changes, save your file so you can roll back in case some
issues arise. To pull information from a Detailed Sheet to the Main Sheet,
Copy the Contents on the detailed sheet and then go to the Main Sheet
and delete the old content. At this point, simply Paste the content in your
clipboard. You may have to re-arrange the map depending on how large
the clip was and how the map is laid out. At this point you can delete the
Sheet from which you drew the information. Remove the Linkage Icon
from the Main Sheet and then simply “Create New Sheet from Topic.”
Rename it and move it to where you want the sheet.

And company to introduce more advanced features. That said, it is useful
to review each of the menu tabs to point up some basic functions you will
need to successfully mind map. The Menu Folders at the top of the map
screen can be accessed by clicking on them, or by using the shortcuts
(e.g., ALT-F for File, ALT-E for Edit; some operating systems will use
CTRL instead of ALT). Once opened, the tabs are organized hierarchically,
indicating additional shortcuts and in some cases, pointing to an expansion
menu for more detailed functions.

File Menu

. PRINCIPAL |
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Exhibit 17: File Menu : e ko e
B XMind_ Tutorial vl xmind The File Menu is fairly familiar,

File Edit View Insert Modify Tools Window Help contalnlng the basic NEW, Open

B ' CtieN | Recent, and Close functions.
New Blank Map CtrleshiftsN | The Save functions provide
i Cirls 0 * some additional options

Open Recent > | including Versioning in which
i i XMind keeps a copy and log of
Close All CtrisShifteW | your files without requiring any
i Rt A | naming convention. However, if
AR you are collaborating with

Save All Ctri+Shift+S | others and/or making

Save As Template... continuous changes, |

recommend adopting some
version number (e.g.,
Project1_v1) to make sure you
and your colleagues are both

Save to Evernote... !

Reduce File Size
Set Password... [Pro]

b
Print Ctri+P g

looking at the same file.
Import...
o If you have the Pro version,
Saes there are some additional
Exit feature related to Password

Protection, Import and Export.
Sharing gives you a number of
options for providing others
access to your maps, either in
public or private forums.
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Edit
Overview
The Edit Menu allows you to perform some common tasks. Whether the
individual items are available depends on whether you are on a TOPIC
when you select the Edit Menu or elsewhere on the map. In general, the

shortcuts are the same as most operating systems, including Undo, Cut,
Copy, Paste.

file Edit View Insert Medify Tools Window Help

Undo Crl+Z
Cut Ctrl+ 2 .
Copy Ctr+C |
Paste CtrlsV |

Ge Central Ctrl+Home |
Select All Ciri+A |

File Edit View Inset Modify Tools Window Help Select Brothe Cori~Shifts |
/" B Topic Enter Select Children - |

Subtopic Tab 3

- ; Check Spelling

Topic Before Shift+Enter

Parent Topic Ctrl+Enter Find/Replace... Ctrl+F

Floating Topic

; = Preferences...

Floating 'Central' Topic A b Pl

Caliout Alt+Enter

Relationship Ctri+L

Boundary Ctri+B

Summary Ctrl+]

Image From File... Cerl+|

Image From Clip Art [Pro]

Irnage From lconfinder [Pro]

32 1 PRINCIPAL
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Hyperlink Ctrl+H

Task Info [Pro]

Attachment
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Exhibit 18: File Menu

Insert Menu

The Insert Menu has a number of
features that can be used in building
~@ outyour mind maps. Depending on
whether you are on a Topic or the
general map canvas, different options
will be bold and active vs. greyed out.

Insert Menu Options

Relationships

The Relationship task allows you to visually point out how some elements
feed into others. This is more of visualization than a project plan since
project planning is a separate component of the Pro version of XMind.

a watyss
S VYD LegaliStakenalder 1__.|_ i SRK le PR [NC’PAL
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xhibit 20: Showing Relationships




Boundary

In addition to Callouts, you can visually highlight an area or set of topics by
Inserting a Boundary. You do not have to completely enfold the topics to
select; just touch them while clicking the Left-Mouse button

Exhibit 21: Boundary Highlight

Neighborhood

B

Community O[ City/Government

l Other Interested Parties

[' | Office
Stakeholders O
i i Retail

| Tenant Classes O Apartment |

industrial

Other |

Summa
. ry

In addition to Boundaries and Callouts, you can Insert Summary to
indicate how certain Topics/Subtopics feed into some conclusion. This is
accomplished similar to boundaries by highlighting the Topics/Subtopics
and then Insert Boundary.
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Exhibit 22: Creating a Summary

1.1.2 Apply Design Thinking

1.1.1 Determine Most Fitting Use )

1.7 Projec Coals & Objectives O 1.1.3 Learn Key Real Estare Fundamentals

1.4 Apply Fundamentals

i 2 "
1.1.5 Communicate Resuits

- 1 K8 "1, Project Overview

@

, 1.4 Implication of Goals & Objectives

| 1.5 Project Guidance

1 >
| 1.6 Optional: Dedision-Making Processes @

AN

Once you have created a Summary button, you can edit it and add
features to populate it with information and/or links.

Exhibit 23: Adding to a Summary

.17 Determine Most Sitting Use

J 1.1.2 Apply Design Thinking 1
1.1 Project Goais & Objectives 113 Learn Key Reai Estate fundamentals t,
IfF 1.1.4 Apply Fundamentals i
JI | 1.1.5 Communicate Results ;
; 1.2 Prigr Project Crizique (6] iy
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PPT

POWER POINT PRESENTATIONS:

PowerPoint presentations are maintained to serve as organized repositories of teaching
materials, facilitating curriculum organization. reference for instructors, and consistency across
classes, especially in courses with multiple educators. These files act as resources for substitute
instructors, archives for past semesters, and references for students. By including presentations,
instructors can ensure quality assurance, compliance documentation, and ongoing improvement
by reviewing and adapting materials based on feedback and advancements in the field. Overall,
course files with PowerPoint presentations streamline the teaching process, support -’
collaboration, and provide a comprehensive resource for effective course management and
delivery.

S.No g Topics : Course Name
1. Overview on Data Mining o Data Mining Techniques
2. Deployment Methods of Cloud computing Cloud Computing
3. Introduction to Operating system Operating System
4. Introduction to Computer Networks Computer Networks
3. Introduction to Design Patterns Design Pattf:ms
6. Smart Home Technologies Database Management System
7 Proposal for the theme on Big Data Analytics Big Data Analytics
8. Seminar Topic On Cryptography and Network
Block Cipher Security & AES " Security
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